
final spine = 0.559

classroom in a book®

The official training workbook from Adobe Systems

Learn Premiere Elements from the ground up 
and create your own customized movie. 
Automate moviemaking and add impressive 
visuals and sound with ease. Back up your 
videos as you go and, when you’re done, take 
them with you and share them wherever you 
go, including your smartphone or tablet.

classroom in a book®

“The Classroom in a Book 
series is by far the best 
training material on  
the market. Everything 
you need to master the 
software is included: 
clear explanations of 
each lesson, step-by-
step instructions, and 
the project files for 
the students.”
barbara binder,  
adobe certified instructor
rocky mountain Training

The fastest, easiest, most comprehensive way to learn 
Adobe Premiere Elements 12
Classroom in a Book®, the best-selling series of hands-on software training 
workbooks, offers what no other book or training program does—an official 
training series from Adobe Systems Incorporated, developed with the support 
of Adobe product experts.

Adobe Premiere Elements 12 Classroom in a Book contains 12 lessons that cover 
the basics, providing countless tips and techniques to help you become more 
productive with the program. You can follow the book from start to finish or 
choose only those lessons that interest you.

Purchasing this book gives you access to the downloadable lesson files you 
need to work through the projects in the book, and to electronic book updates 
covering new features that Adobe releases for Creative Cloud customers. For 
access, go to www.peachpit.com/redeem and redeem the unique code provided 
inside this book.

What you need to use this book: Adobe Premiere Elements 12 software, for 
either Windows or Mac OS. (Software not included.)

note: Classroom in a Book does not replace the documentation, support, 
updates, or any other benefits of being a registered owner of Adobe Premiere 
Elements 12 software.

CATEGORY: 
DIGITAL VIDEO / VIDEO EDITING
Adobe Press books are published 
by Peachpit, San Francisco, CA
Printed and made in the USA

www.adobepress.com

Us $54.99 
CANADA $57.99

 facebook.com/ 
PeachpitCreativeLearning

 @adobepress

cla
ssro

o
m

 
in

 a
 bo

o
k

®

9780321949813_APremiereElements12CIB_Cvr.indd   1 10/2/13   5:18 PM

Instructor Notes



Adobe® Premiere® Elements 12 Classroom in a Book®

© 2014 Adobe Systems Incorporated and its licensors. All rights reserved.

If this guide is distributed with software that includes an end user agreement, this guide, as well as the 
software described in it, is furnished under license and may be used or copied only in accordance with the 
terms of such license. Except as permitted by any such license, no part of this guide may be reproduced, 
stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, record-
ing, or otherwise, without the prior written permission of Adobe Systems Incorporated. Please note that 
the content in this guide is protected under copyright law even if it is not distributed with software that 
includes an end user license agreement.

The content of this guide is furnished for informational use only, is subject to change without notice, and 
should not be construed as a commitment by Adobe Systems Incorporated. Adobe Systems Incorporated 
assumes no responsibility or liability for any errors or inaccuracies that may appear in the informational 
content contained in this guide.

Please remember that existing artwork or images that you may want to include in your project may be 
protected under copyright law. The unauthorized incorporation of such material into your new work 
could be a violation of the rights of the copyright owner. Please be sure to obtain any permission required 
from the copyright owner.

Any references to company names in sample files are for demonstration purposes only and are not 
intended to refer to any actual organization. 

Adobe, the Adobe logo, Premiere, Flash, Photoshop, Revel, and Classroom in a Book are either registered 
trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Apple, Mac OS, and Macintosh, and QuickTime are trademarks of Apple, registered in the U.S. and other 
countries. QuickTime and the QuickTime logo are trademarks used under license. The QuickTime logo 
is registered in the U.S. and other countries. Microsoft and Windows are either registered trademarks or 
trademarks of Microsoft Corporation in the U.S. and/or other countries. All other trademarks are the prop-
erty of their respective owners.

Adobe Systems Incorporated, 345 Park Avenue, San Jose, California 95110-2704, USA

Notice to U.S. Government End Users. The Software and Documentation are “Commercial Items,” as that 
term is defined at 48 C.F.R. §2.101, consisting of “Commercial Computer Software” and “Commercial 
Computer Software Documentation,” as such terms are used in 48 C.F.R. §12.212 or 48 C.F.R. §227.7202, 
as applicable. Consistent with 48 C.F.R. §12.212 or 48 C.F.R. §§227.7202-1 through 227.7202-4, as applica-
ble, the Commercial Computer Software and Commercial Computer Software Documentation are being 
licensed to U.S. Government end users (a) only as Commercial Items and (b) with only those rights as are 
granted to all other end users pursuant to the terms and conditions herein. Unpublished-rights reserved 
under the copyright laws of the United States. Adobe Systems Incorporated, 345 Park Avenue, San Jose, 
CA 95110-2704, USA. For U.S. Government End Users, Adobe agrees to comply with all applicable equal 
opportunity laws including, if appropriate, the provisions of Executive Order 11246, as amended, Section 
402 of the Vietnam Era Veterans Readjustment Assistance Act of 1974 (38 USC 4212), and Section 503 
of the Rehabilitation Act of 1973, as amended, and the regulations at 41 CFR Parts 60-1 through 60-60, 
60-250, and 60-741. The affirmative action clause and regulations contained in the preceding sentence 
shall be incorporated by reference.

Adobe Press books are published by Peachpit, a division of Pearson Education located in San Francisco, 
California. For the latest on Adobe Press books, go to www.adobepress.com. To report errors, please send 
a note to errata@peachpit.com. For information on getting permission for reprints and excerpts, contact 
permissions@peachpit.com.

Book: 
ISBN-13:	  978-0-321-94981-3 
ISBN-10:        	 0-321-94981-1

Instructor Notes: 
ISBN-13:	 978-0-133-52001-9 
ISBN-10:         	 0-133-52001-3

mailto:permissions@peachpit.com


Adobe Premiere Elements 12 Classroom in a Book  3

Instructor notes
Introduction
The Adobe® Premiere® Elements 12 Classroom in a Book® course presents stu-
dents with tips, techniques, and solutions for using Adobe Premiere Elements. 
These Instructor Notes are intended to complement the information in the Adobe 
Premiere Elements 12 Classroom in a Book. 

The information is organized to follow the sequence of instruction in each lesson. 
However, the notes are not intended to expand on each and every exercise but 
rather to point out potential teaching opportunities not specifically covered in the 
lesson or areas where students might easily be confused. 

Course strategy
The book includes a Getting Started chapter and 12 lessons, which will take various 
lengths of time to complete. You can teach approximately one chapter of this book 
per session but—depending upon the number and duration of sessions in your 
class—you may wish to combine related exercises from some of the shorter lessons, 
or split up the more involved lessons. To this end, you should personally assess 
the complexity of the exercises in each lesson. Some non-essential exercises—and 
exercises that require Internet access when online connections are not available in 
the classroom—may best be assigned as follow-up homework. 

The following lesson summaries will help you structure your course:

•	 Getting Started explains how to install the application software and how to 
copy the lesson files from the application CD into the lessons folders. In the 
classroom setting, this instruction is best combined with Lesson 1, so your 
students will have access to a project with videos when they begin to explore the 
application interface. 

Please note that several of the projects used in these lessons include content, 
such as templates, that is available only in a full installation of Adobe Premiere 
Elements. Accordingly, you should advise your students to perform a complete 
application installation. Also note that the lessons and associated files used in 
this book will occupy over 2.4 GB of hard disk space. 

Although substantial care went into ensuring that all project files will 
automatically locate component files without user intervention, it’s impossible 
to predict all installation scenarios, particularly since the product is cross-
platform, Mac and Windows. We hope that neither you nor your students will 
encounter problems; but if you do, you should be able to locate any unfound 
files and relink them within Adobe Premiere Elements. 
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•	 Lesson 1 describes how students will use Adobe Premiere Elements to produce 
movies while introducing them to the key panels, workspaces, and views found 
in Adobe Premiere Elements. 

•	 Lesson 2 teaches how to create a project, set relevant user preferences, and 
configure the interface. If some students are tempted to skip this chapter, you 
might advise them that they will not be able to change their project settings 
after they’ve chosen those settings and started editing. While Adobe Premiere 
Elements is a flexible and customizable program, your students may have to 
redo their work if they start a project with wrong settings. 

Depending on your class schedule, you should consider teaching at least 
Lessons 1 and 2 in concert because they are both introductory in nature and 
relatively brief. 

•	 Lesson 3 explains how to capture and import video from camcorders and other 
video devices in Adobe Premiere Elements. Students learn how to connect a 
camcorder to their computers; and use Video Importer to import video from an 
AVCHD camcorder, digital still camera, DVD, or DVD-based camcorder. They’ll 
also discover how to import audio, video, or still images already located on their 
hard drives. 

Although no project file is provided with this chapter, the final exercise does 
guide the student in importing book content from a folder on her hard drive. 
The capture process is very device specific, and you should consider how best to 
illustrate this in a class setting when students are using a multitude of different 
video devices, or have no classroom access to any video device. 

•	 Lesson 4 introduces students to the organizational workspaces in Adobe 
Premiere Elements; which includes a full version of the Elements Organizer. 
Students will use each workspace, and also dive into Adobe Premiere Elements’ 
Auto-Analyze feature that adds Smart Tags to the content, which feeds into 
Adobe Premiere Elements Smart Fix and Smart Trim functions and Instant 
Movie functionality. Students customize and create an Instant Movie as part of 
this lesson. 

•	 Lesson 5 details Adobe Premiere Elements’ Quick and Expert views, and 
explores various “nuts and bolts” editing tasks, such as inserting, deleting, 
splitting, and rearranging clips in both views. Students also learn how to work 
with Smart Trim in Adobe Premiere Elements. 

•	 Lesson 6 is the Effects lesson. Students learn the difference between curative 
and artistic effects, and when and how to apply them. You’ll also introduce 
them to Adobe Premiere Elements’ Smart Fix function, and the program’s 
ability to apply one effect to many clips, and remove effects from many clips 
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simultaneously. Specific tasks include improving video appearance via Premiere 
Elements Color (RGB) effect, creating a pan and zoom effect with a still 
image, controlling effects with keyframes, creating a picture-in-picture effect, 
and compositing one video with another using Adobe Premiere Elements’ 
Videomerge function. 

•	 Lesson 7 demonstrates how to add nuance and dimension to movies by using 
transitions between clips. Students apply a transition to single and multiple clips, 
preview transitions, customize transition settings, copy and paste transitions, 
create fade-ins and fade-outs, and render transitions for high quality preview. 

•	 Lesson 8 examines Adobe Premiere Elements’ title-related tools. Students create 
original titles and rolling credits for a production, and use some of the title 
templates that are installed with the application. 

•	 Lesson 9 examines the multiple audio-related features in Adobe Premiere 
Elements, including a real time narration tool; the ability to create, add, 
and modify background music tracks; and the multi-track mixer that can 
control volume levels within clips. To explore these features, students create 
a background music track, adjust the volume of an audio clip, add a narration 
clip, and mix the audio with Smart Mix and Adobe Premiere Element’s Audio 
Mixer for maximum impact. 

•	 Lesson 10 is aimed at students who want to record their projects on a DVD or 
Blu-ray disc, upload their content to a Web DVD, or create an AVCHD disk, a 
format that records HD videos onto a standard DVD for playback on a Blu-
ray player. Students add menu markers to their videos, create, customize, and 
preview menus; and then burn a DVD or Blu-ray disc. Since Adobe Premiere 
Elements can record a disc image to a hard drive (in addition to recording the 
content to an actual disc), your students don’t need a DVD or Blu-ray recorder 
to follow along with this lesson. 

•	 Lesson 11 explains how students can share their videos with friends, families, 
and associates, including uploading their videos to YouTube, exporting a 
video file for subsequent viewing from a hard disk or mobile video device, and 
recording video to DV/HDV tape media. 

•	 Lesson 12 shows how to use Adobe Photoshop Elements and Adobe Premiere 
Elements in concert to seamlessly combine digital photography and video 
editing. Students create a Photoshop file optimized for video and edit a 
Photoshop image within Adobe Premiere Elements. To complete these lessons, 
students must have Adobe Photoshop Elements installed on their computers.
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Managing student projects
One way to simplify file storage and retrieval in classroom situations is to ask stu
dents to create a folder on their hard disks, name it [Student’s] Lessons (substitut
ing the student’s actual name for “Student”), and then copy each project folder into 
the main Lessons folder. Having students keep all their working files in their own 
Lessons folder makes it easy for you to clean up files when a class is over. 

New features
The most significant new features in Adobe Premiere Elements 12 are as follows:

•	 Guided Edits. The Adobe Premiere Elements interface now has a third tab 
named Guided that contains Guided Edits, a feature carryover from Photoshop 
Elements. In the early version of Premiere Elements, there are nine Guided 
Edits, the first providing a quick overview of how to edit a project in Premiere 
Elements, then others covering specific functions like trimming, adding 
transitions and color correction. Once you choose a Guided Edit, you’ll see 
instruction on the upper left hand side of the interface, with arrows and 
highlights pointing you towards the relevant controls. Note that you can 
choose a Guided Edit in both Quick and Expert views. 

All Guided Edits are different, but typically you click next to move from step to 
step. Often, you’ll have to perform a function within Adobe Premiere Elements 
to move to the next step. 

•	 Motion tracking. It’s back! Motion tracking lets you track an object in the video 
and then attach a graphic to that object, like a thought bubble. Yes, this was a 
feature in Premiere Elements 10 that was removed in Premiere Elements 11. 
Now it’s back and covered in Chapter 6. 

•	 Adjustment layers. Adjustment layers let you apply a single effect—like a movie 
look—to multiple clips. It’s a great technique for applying effects like color 
correction to all clips shot in the same location, or to create a common look or 
feel for your entire movie. You’ll learn how to apply and con-figure adjustment 
layers in Lesson 6.

•	 Scores. Scores are background audio tracks that adjust to the length of your 
production. Like all background music, they enhance the atmosphere of the 
video and add a polished touch. You’ll learn how to apply scores, which replaces 
SmartSound, in Chapter 9, 

•	 Integration with Adobe Revel. Revel is a photo and video app for your Mac, 
iPad and iPhone. Upload to the web-based service once, and you can edit your 
photos and videos online, and share them to various picture and video sharing 
sites on the Internet. 
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Getting Started
Before beginning Lesson 1, you should decide how to handle the issue of software 
and lesson file installation from the CIB DVD to the student computers. You may 
wish to prepare lesson folders for your students before the first classroom session, 
or teach this procedure, along with the creation of work folders and initial catalog 
files, as part of Lesson 1.

Note that the only essential procedure found in Getting Started that is not covered 
in Lesson 1 is reconnecting missing files to a project. 

Lesson 1: The World of Digital Video
This lesson introduces how students will use Adobe Premiere Elements to produce 
movies and previews the key panels, workspaces, and views they’ll use in Adobe 
Premiere Elements. 

In a classroom situation, it would be best to complete the Getting Started section 
before you begin these lessons. 

Goals for this lesson
The objective for Lesson 1 is to familiarize your students with the Adobe Premiere 
Elements user interface so they can locate the commands and controls they’ll need 
to import and edit various content types into their movies. 

•	 They should be able to load a project or start a new project. 

•	 They should be able to identify and locate the key elements of the interface, 
including menus; the Monitor, Quick and Expert view timelines, Guided Edits, 
the Action Bar, and Add Media, Tools, Adjust, Applied Effects, and Publish 
+Share panels. 

Opening discussion
Your students undoubtedly will be anxious to start editing their videos, but also a 
bit apprehensive about learning a new program. Let them know that the first two 
lessons will be introductory but that, starting with the third lesson, they’ll be cap-
turing video and fully editing video by the fourth lesson. 

Discuss that learning the interface and workflows will help them become more effi-
cient for all future projects. Though the activity is not as exciting as actual editing, 
it’s an essential step in mastering video editing.
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How Adobe Premiere Elements fits into video production
Before opening Adobe Premiere Elements, start by discussing the movie making 
process in general, from importing content, to editing, to rendering, to final format 
for sharing. Consider reviewing the table of contents and spending a few moments 
discussing what the students will learn and accomplish in each lesson. 

Then open Adobe Premiere Elements, and Click Organize to open the Elements 
Organizer, not Adobe Premiere Elements. Note that you’ll actually create the proj-
ect in the Organizer. Try to get through this phase quickly, and advise the students 
that you’ll spend more time working in the Organizer in Chapter 4. 

Once in Adobe Premiere Elements, walk each student through the following steps 
to ensure a consistent interface:

1	 Choose Window > Restore Workspace, to restore the workspace to the default 
configuration. 

2	 Click the Quick view button on top of the Monitor to make sure all students are 
working in that view. 

Then, begin a general tour of the workspace, including the menu bar, the Monitor 
panel, the Quick and Expert view timelines, Guided Edits and the Action Bar. It’s 
best if you adapt the language used in the book and in the help file so the students 
learn consistent terminology. For example, resist the urge to call the Monitor panel 
the “preview panel.”

Orient the students as to how the interface facilitates the project workflow that you 
just discussed in the table of contents. Point out that students will import content 
from the Add Media panel, edit in the Quick or Expert view timeline, and preview 
(and perform some titling and menu creation functions) in the Monitor panel. Then 
move to a discussion of the individual panels. 

Remember, this lesson is just a quick fly-by, not an intense, getting-acquainted 
section. Assure the students that they’ll spend much more time in each panel in 
later lessons. 

Monitor panel 
Point the students to the Monitor panel. Note that its key function is to preview the 
edits performed in the Quick and Expert view timeline, and to display the Guided 
Edits. Ask the students to turn down the volume on their speakers to avoid distrac-
tion as you do the same. 

To match the screens in the book, consider working in the Quick view timeline. Then, 
working with the students, click the first clip in the Quick view timeline, and then 
click the Play button. Let the video play for a few moments, and then click Pause. 
Discuss that the controls are similar to a typical VCR or computer video player. 
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Have your students drag the current time indicator around the timeline, observing 
that this is the actual edit point in the video. Ask the students to leave the current 
time indicator positioned near the end of the first clip. 

Identify the icons at the lower-right of the Monitor panel for rendering and resiz-
ing the information shown in the timeline. As you know, these controls are critical 
to navigating around projects and are integral to successful editing. Hover your 
pointer over each icon to show its tool tip. 

Right-click within the Monitor and show the Magnification settings, which control 
the size of the video previewed in the Monitor. Make sure that it’s set to 100%. 

Quick and Expert view timeline
Point your students toward the timeline. Identify the Quick and Expert views. 
Describe each view, toggle between the two, and have your students do the same. 

You’ll discuss the advantages and disadvantages of both interfaces in Lesson 5, so 
hold off on that for now. 

Interface overview
The Premiere Elements interface has been de-cluttered so that the two dominant 
windows are the Monitor and timeline. Tools and panels have been clustered in 
three areas. 

Add Media and Project Assets panels (Upper Left)

On the upper left of the interface are the Add Media and Project Assets (Expert 
view only) panels where your students will add content to the project and manage 
that content. Point these out to your students.

Action Bar (Bottom Right)

The Action Bar on the bottom provides access to tools (the Tools panel) and all 
libraries of content supplied with Adobe Premiere Elements, like Transitions, Titles 
& Text, Effects, Music and Graphics. Point these out to your students. In particular, 
spend some time with the individual tools in that panel, including the Movie Menu 
tool for applying menus, the Pan & Zoom tool for panning and zooming around a 
still image or video and the Time Remapping tool for customizing the speed and 
direction of their videos. 

Adjust and Applied Effects panels (Upper Right)

These two panels enable students to customize the native adjustments available on 
each clip (Adjust panel) or effects applied to each clip (Applied Effects).

Publish + Share Panel (Upper Right)

Once the student has completed editing, open this panel to share the project. 
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A few points about these panels. First, they all open and close the same way; you 
click the panel to open it and click it again to close it. Second, regarding the con-
tent panels in the Action Bar, make the point that the contents will different in the 
Quick and Expert views. Also make the point that the Project Assets panel only 
appears in Expert view. 

Questions
1	 What are the primary differences between the Quick and Expert views?

2	 What’s the difference between the Adjust and Applied Effects panels. 

3	 Where do you click to render your movies into final format for distribution to 
friends, family, or associates? 

Answers
1	 The Quick view has fewer tracks, presents the clips as draggable scenes, doesn’t 

have access to the Project Assets panel and doesn’t provide access to all tools 
or content in their respective panels. The Expert view shows all clips in a 
traditional timeline with unlimited tracks and access to all tools and content in 
their respective panels, as well as access to the Project Assets panel. 

2	 The Adjust panel includes adjustments available for all clips. The Applied Effects 
panel lets you adjust effects that you’ve applied to your clips. 

3	 Click the Publish+Share button to open that panel. 
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Lesson 2: Getting Ready to Edit
This lesson describes how to create a project, set relevant user preferences, and 
configure the interface to suit individual workflows. Depending upon your class 
schedule, you should consider teaching Lessons 1 and 2 in concert since they are 
both introductory in nature and fairly brief. 

Goals for this lesson
The objectives for this lesson are to teach your students how to choose the opti-
mal presets for their projects, to set relevant preferences, and to customize Adobe 
Premiere Elements’ application interface. 

•	 Your students should be able to access the Project Settings screen, and choose 
the optimal preset for their source video and the target output. 

•	 They should be able to recognize and diagnose settings-related issues. 

•	 Students should be able to access and choose Project preferences such as 
scratch disk location. 

•	 They should be able to drag Adobe Premiere Elements panels to a new 
configuration and then reset the workspace to the default configuration. 

Opening discussion
The key point here is that you can’t change project settings after you start edit-
ing your project. If you don’t get it right up front, and have to make a change later, 
you’ll lose all of your work. That should get the students’ attention. 

The big news here is that Adobe now automatically chooses the correct sequence 
preset for most projects, which should eliminate most of these mismatches. Still, 
this doesn’t work 100% of the time, so students still need to know how to identify 
and resolve mismatches between content and the sequence preset. 

Setting up a new project
In this exercise, students will open a project file with content that matches the pre-
set and content that doesn’t (Lesson02_Start_Win/Lesson02_Start_Mac). Open the 
project, switch to Expert view (if necessary) and discuss what letterboxes are and 
when they appear, and what the orange lines in the time scale area mean. 

Click Edit > Project Settings and show the students where they can identify the 
settings for that project. If you have the time, start two new projects. Show the 
students how to choose the project setting and how and when to force a project 
setting (do not force the project setting). Make the point that the default project 
setting is that used for the last project that Adobe Premiere Elements created, 
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which will obviously differ from machine to machine. In this instance, choose the 
project setting AVCHD > AVCHD LITE 720p 30. 

With the first new project, import file 5.mov from the Lesson 2 folder and drag it 
into the timeline. Then click Edit > Project Settings again and show the students 
that Adobe Premiere Elements changed the setting to QuickTime DV to match the 
first imported clip. 

Then start your second new project (don’t bother to save the first, and feel free to 
overwrite the project you just closed). The project setting should now be NTSC-
DV-Standard 48kHz because that was the setting Premiere Elements used for the 
previous project. Import Gator 1.mov into the project and drag it into the timeline. 
Then click Edit > Project Settings again and show the students that Adobe Premiere 
Elements changed the setting to AVCHD 720p square pixel to match the first 
imported clip. 

Ask the students to identify the camcorders that they’ll be using for their own pro-
ductions, and then discuss the optimal preset for their content. 

Working with project preferences
In this exercise, students configure various Adobe Premiere Elements prefer-
ences. Discuss the importance of each configuration option as you examine them, 
and make the point that changing most preferences is applied prospectively, not 
retroactively. That is, if you change the default transition duration, it changes only 
transitions that you apply after making the change, not those you have already 
inserted into the project. 

Customizing the workspace
This exercise walks the student through the customization options for their 
workspace. Make the point that they probably will reposition their interface ele-
ments frequently while creating a project; for example, maximizing the size of the 
Monitor panel while customizing effects, and boosting the size of the Quick and 
Expert view timeline when adding titles and other content to the timeline. Finally, 
reinforce that the student can easily restore the default workspace by choosing 
Window > Restore Workspace. 

Homework assignment
Ask students to create a project at home using the best preset for their source 
footage and to input some video from that source. Ask them to write down their 
experiences to briefly recount which preset they used and whether they experi-
enced any problems. 
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Mixed format project
Though not covered in the book, some students may ask about mixed format 
projects that combine widescreen DV and AVCHD footage. In these situations, 
the preset strategy should depend upon the output target. 

That is, if producing for SD DVD, use a DV preset. Import and insert the DV 
footage into the timeline first to set the project setting. Then import the AVCHD 
footage as normal, and when you add the AVCHD footage to the Quick and 
Expert view timeline, Adobe Premiere Elements will automatically scale it to the 
lower resolution. 

If producing for Blu-ray disc output, or any other HD format, use an AVCHD proj-
ect preset. Import and insert the AVCHD footage into the timeline first to set the 
project setting. Then import the DV footage as normal, and when you add it to the 
Quick and Expert view timeline, Adobe Premiere Elements will automatically scale 
it to the higher resolution. The video may look a bit grainy because of this scaling, 
but that’s an unavoidable artifact of the process. 

Questions 
1	 If you change the preferences value for transitions, which transitions are affected? 

2	 What are scratch discs, and why is it important to know their locations? 

Answers
1	 Changing preferences for transitions (and any other content) effects only those 

transitions that are applied after the preference change, not transitions that are 
already included in the project. 

2	 Scratch disks store content captured or created while producing a movie. It’s 
important to know their locations so you can ensure that you have sufficient 
storage space available during a project and also to enable you to delete the 
content once you’ve finished editing. 
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Lesson 3: Video Capture and Import
Lesson 3 describes how to capture and import video from camcorders and other 
devices into Adobe Premiere Elements. Exercises detail how to connect a cam-
corder to a PC; how to use Video Importer to import content from various devices; 
and how to import audio, video, or still images from hard drives. 

A project file is not provided with this chapter, though the final lesson does walk 
the student through importing content from a folder on her computer. Capture is 
very device specific, and you should consider how to best illustrate this in a class 
setting when students have a wide variety of video devices, or have no classroom 
access to any device. 

Note that two basic capture interfaces are discussed, one for clip-based devices 
(AVCHD, DSLRs, DVD, digital still cameras, mobile phones), and one for tape (DV, 
HDV). If you can demonstrate how to capture from one device using each interface 
type, your students should be well equipped for whatever formats they may encounter. 

When planning this lesson, be sure to check the capabilities of the computers that 
you and the students will be using. Nearly all modern computers have USB ports, 
but far fewer also have IEEE 1394 (FireWire) ports. 

Goals for this lesson
The objectives for Lesson 3 are to enable students to ingest footage from multiple 
sources into Adobe Premiere Elements, using multiple connections. 

•	 Students should know how to import video from devices that store the video on 
SD or other memory cards, including AVCHD and cell phone cameras, Digital 
SLRs and other cameras that shoot video, DVD video and digital pictures.

•	 Your students should understand how to connect a camcorder to a computer 
PC for ingesting content. 

•	 They should know which technique to use to capture their source footage.

•	 They should know how to import video stored on a hard drive into an Adobe 
Premiere Elements project. 

Getting started
Your students will have to create a project to complete this lesson. The project 
preset they choose should conform to whichever format they intend to import. For 
example, if they plan to import the video included on the DVD, they should use 
AVCHD LITE 720p 30 preset. If they plan to capture HDV, use the HDV preset. 

The easiest way to involve students is to capture video from a digital camera or 
smart phone (virtually all digital cameras and smart phones shoot video). Ask the 
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students to bring their devices and USB cables to class to connect their devices to 
their classroom computers. 

Review the details of the System setup sidebar to make sure students understand 
what’s needed in a capture/editing station. 

Opening discussion
Make the point that capture setup and workflow is very device specific. If you can, 
try to preserve some time at the end of the class to address student-specific sce-
narios, and encourage the students to ask about their unique setups. 

Capture interfaces
Click the Add Media button to open that panel. Note that seven capture options are 
available, but really only two capture interfaces, the Video Importer (click the Videos 
from Flip or Cameras button) and the Capture window (click the DV Camcorder 
button). Identify the source devices in the Add Media panel during class and dis-
cuss how the student should proceed if the capture source device isn’t specifically 
addressed. In particular, advise students that Videos from Flip or Cameras is the cor-
rect option when capturing from a smart phone or digital camera. 

Using the Video Importer
This lesson is straightforward, and can be performed with a digital camera, smart 
phone, AVCHD camcorder, or DVD. At step 7, have your students preview one or 
two video files before ingest. 

Capturing tape-based or live video
Ask the students if anyone is working with DV or HDV source video. If not, con-
sider skipping this lesson. If some are, walk the students through the steps of con-
necting to a computer to a DV or HDV camcorder. Be sure to review the difference 
between 4-pin and 6-pin IEEE 1394 connectors and advise students to get a cable 
that matches their hardware. For example, while most desktop computers support-
ing IEEE 1394 use 6-pin connectors, most notebooks that do so use 4-pin connec-
tors. Virtually all camcorders use a 4-pin connector, so if a student is capturing to a 
notebook, he would need a 4-pin/4-pin cable. 

Review the various capture options, especially scene detection and Smart Tagging. 
If using a DV or HDV camcorder, establish device control within Adobe Premiere 
Elements and capture some video. 

Many things can go wrong during capture, so you should be very familiar with the 
process and be able to debug it on your capture station before conducting your class. 
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Importing content from your hard disk
This is the one exercise that all students should be able to perform, and one that 
they will use frequently during the course of their editing. 

Questions
1	 What devices typically use a IEEE 1394 cable to connect to a computer? 

2	 What devices typically use USB? 

3	 How can you locate where Adobe Premiere Elements is storing your 
captured video? 

Answers
1	 DV and HDV camcorders. 

2	 AVCHD camcorders and digital cameras. 

3	 You can choose a scratch disk in Preferences.
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Lesson 4: Organizing Your Content
Lesson 4 teaches students how to search for and organize content for Premiere 
Elements projects, and how to use Adobe Premiere Elements’ Smart Tagging and 
Instant Movie functionality. Students customize and create an Instant Movie as 
part of this lesson. 

Goals for this lesson
The objectives for Lesson 4 are to familiarize students with Adobe Premiere 
Elements’ main content workspaces, the Elements Organizer, the Project Assets 
panel (Expert view only); and to explore Smart Tagging and Instant Movies; and to 
detail how to work with the Auto-Analyzer function. 

•	 Your student be able to manually tag their clips in the Organizer, and to apply 
Smart Tagging. 

•	 They should be able to enable and disable the Auto-Analyzer function. 

•	 Your students should be able to create an Instant Movie using manual and 
Smart Tagging. 

•	 They should be able to add content into the Quick and Expert view timeline. 

Getting started
The number of goals immediately indicates that this chapter contains lots of mate-
rial. Unfortunately, while organizing content never quite sounds as exciting as 
trimming, cutting, and adding effects, the skills in this chapter are fundamental to 
efficient editing, and central to the valuable organizational capabilities of Adobe 
Premiere Elements. 

It is absolutely critical that students complete this lesson with a clear understand-
ing of the content contained in the Organizer and in Premiere Elements Project 
Assets view, and when and how to use each view. When studying the Elements 
Organizer, they should grasp the benefits of the Auto-Analyzer, including Smart 
Tagging, and how and why to apply manual Tagging. 

For most other lessons, simply working through the exercises can transfer the criti-
cal knowledge. In this lesson, however, the instructor must synthesize the exercises 
into high-level concepts to ensure that students “get it.” In this regard, the instruc-
tor may want to spend a bit more prep time working through this lesson. 

Opening discussion
Organization sounds boring, but it’s essential to efficient editing. Adobe Premiere 
Elements has three interfaces that help producers work more efficiently. 
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The Elements Organizer is the master organization tool for collecting and tagging 
and then deploying all still image, video and audio content loaded on the computer. 
The Elements Organizer contains functions like Smart Tags that can cut down 
movie creation time to mere minutes. It’s also invaluable for finding content to use 
in subsequent projects. 

The Project Assets panel (Expert view only) contains all the content imported into 
the project, and it offers features like trimming and sorting tools. In previous ver-
sions of Premiere Elements, the Project Assets panel provided access to many of 
the same searching tools as the Elements Organizer, but it no longer does. Instead, 
use the search tools in the Organizer to find the desired content and drag it into 
Premiere Elements’ Project Assets panel. 

Working in the Project Assets panel 
This section works through the search capabilities in the Project Assets panel and 
finishes by detailing how to add clips to the project. 

Tagging in the Organizer
Open the Elements Organizer and define the “big picture” benefits of manual 
and Smart Tagging (via the Auto-Analyzer) which include the easy ability to find 
relevant content and automated functions like Smart Trim, Smart Fix and creating 
Instant Movies. 

Note that the Elements Organizer now makes it simple to organize clips into 
groups for People, Places and Events, which is a great convenience for many pro-
ducers. After this explanation, the lessons regarding manual tagging are straightfor-
ward and can be worked through quickly. 

About the Auto Analyzer
Detail how to manually run the Auto Analyzer, and describe what it does. Then 
review the information that it collects and how it drives functions like Smart Trim 
and Smart Fix and enhances the Instant Movie functions. 

However, advise the students that on underpowered computers with slow CPUs 
or limited RAM, the Auto Analyzer running in the background could make the 
computer sluggish or unstable, particularly when working with HD source foot-
age. Be sure to review how to disable this function in the Elements Organizer 
Preferences window. 

Creating an Instant Movie
This is the payoff, and the exercise is fun and fast. At some point, make these points 
about what an Instant Movie does and doesn’t do. 
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•	 Instant Movie creates a music video using the clips in the Project Assets panel. 
If there’s dialog you’re hoping to maintain, forget it. You can’t tell a story with 
an Instant Movie, but you can create a short, fun montage that showcases a trip 
or event. 

•	 You can use an Instant Movie as a section of a larger production. For example, if 
you are producing a wedding video, you could include the ceremony and toasts 
in their entireties, and use an IntantMovie to depict the reception or parties. 

•	 When creating an Instant Movie, you can’t trim or edit the clips in advance 
hand. You just select or deselect them. You can edit the Instant Movie after it’s 
created (show the students how to do this), but this might throw off the tempo 
and timing. If you want more control, you can apply a Theme to clips on the 
Timeline, though this is not demonstrated in the book. 

Questions
1	 Ask the students about the utility of the Elements Organizer. For students who 

work with pictures and video, ask how many would invest the time for manual 
tagging. Ask questions to make sure they understand the utility of the Auto-
Analyzer function, and when to consider disabling it. 

2	 What are the advantages and disadvantages of Instant Movies vs. applying a 
Theme to content on the Timeline? 

Answers
1	 Utility of the Elements Organizer

•	 Allows users to categorize content into People, Places and Events. 

•	 A great starting point for projects using disk-based assets, especially where 
you need to search through a number of files to find the right ones. 

•	 The Auto-Analyzer produces Smart Tags used for Smart Trim, Smart Fix, 
and creating Instant Movies, along with providing tags that students can use 
to find or eliminate certain classes of content, like shots with faces or shaky 
or low quality footage. 

•	 While analyzing clips, the Auto-Analyzer consumes lots of system resources. 
Consider disabling if editing becomes unresponsive or if the system 
becomes unstable. 

2	 Instant Movies are created from clips in the Project Assets panel or Elements 
Organizer. You could also select clips via Tagging and Smart Tagging in the 
Organizer, drag them to the Timeline, and then apply a Theme. 

When using Instant Movies, you have no real editing input beyond selecting 
the clips to include. You can cut out portions of any clip that you don’t want 
included before applying a Theme. 
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Lesson 5: Editing Video
Lesson 5 introduces students to Adobe Premiere Elements’ Quick and Expert view 
timelines, and to fundamental editing tasks like inserting, deleting, splitting, and 
rearranging clips in both views. It also introduces the student to Adobe Premiere 
Elements time saving feature, Smart Trim. 

Goals for this lesson
The objectives for Lesson 5 are to enable students to perform basic editing tasks in 
both the Quick and Expert view timelines. 

•	 Your student should appreciate that trimming, cutting, splitting, and deleting 
video is fundamental to creating high-quality, watchable movies. 

•	 Your student should understand how to use Smart Trim mode to quickly 
remove lower-quality segments from their videos. 

•	 They should understand the difference between the Quick and Expert view 
timelines; when to use each; and how to insert, move, trim, split, and delete 
clips in each. 

•	 Your students should become very capable with the Monitor panel in both the 
Quick and Expert view timelines. 

•	 They should learn keyboard shortcuts to speed their editing. 

Getting started
Basic editing skills, such as those taught in this chapter, are the most important 
fundamentals that students can learn. This chapter is long, with lots of material to 
process. In a classroom setting, you should consider dropping the section on the 
Quick view and moving directly to the Expert view. 

There are two Guided Edits relating to the content presented in this chapter; 
Getting started with Premiere Elements, and Trimming Unwanted Frames. 
Consider pointing these out as potential refreshers for when the students are edit-
ing away from class. 
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Opening discussion 
For the movie Gone with the Wind, IMDB reports that over 500,000 feet of film was 
shot, but only 20,000 feet was used in the actual production, about 4% of the total 
footage. While your students probably won’t cut that much from their productions, 
it’s important to stress that the best way to make a movie watchable is to cut as 
much footage as possible. 

Though it’s hard to imagine that GWTW director Victor Fleming lived by this 
creed (the movie was 226 minutes long), shorter is almost always better for per-
sonal and business-related movies. As a result, skills learned during this lesson are 
critical to producing watchable films. 

Working with the Monitor panel
You and your class may be tempted to skip through this section because it’s so 
basic, but students should use each control to identify its function. In class, per-
form each step of the exercise with the students to ensure their comprehension. 

You should also describe what rendering is, why it’s important sometimes (and why 
it’s not important for all edits), and how to render a work area of the timeline. 

Editing in Quick view
You should have touched on the Quick view timeline in previous lessons. Reiterate 
its advantages:

•	 Simple to understand (if you can create slideshow, you can create a movie). 

•	 Very easy to shift content around. 

And its disadvantages:

•	 Somewhat cumbersome when you have placed multiple clips at the same spot in 
the project (layered clips). 

•	 Cumbersome when you are using content that spans more than one piece of 
content, like a background music track, or title above multiple clips. 

•	 Incomplete access to all panels (no Project Assets panel) and incomplete access 
to content in other panels. 

Emphasize skills learned during the trimming and splitting sections. Observe that 
splitting is a key skill even when capturing with scene detection enabled because 
producers often have to carve multiple scenes out of a single clip. 

Working through the exercises should be straightforward. 
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Working in Expert View
You should have touched on the Expert view in previous lessons. Reiterate its 
advantages:

•	 Offers the best visualization when using multiple layers, or when adding content 
that spans the duration of other content (such as background music). 

•	 Can easily view the duration of each section and the entire movie. 

•	 Full access to all Premiere Elements panels, tools and content.

And its disadvantage:

•	 Not as intuitive as the Quick view timeline.

Emphasize skills learned during the trimming and splitting sections. Observe that 
splitting is a key skill even when capturing with scene detection because often pro-
ducers have to carve multiple scenes out of a single clip. 

Creating a slide show
This is a fun exercise for students working with lots of still images and video. 

Working in Smart Trim Mode
Smart Trim is a feature of Adobe Premiere Elements 12 that automatically identi-
fies regions with quality issues. You should take the time to review both modes of 
operation – manual and automatic – and discuss when to use each. 

If you’re relying heavily on the sample assets on the DVD, make the point that 
because of disc space limits on the disc, most bad footage was chopped out manu-
ally while creating the project. For this reason, Smart Trim may not appear to be as 
valuable as it would be with most original source footage. 

If you can find some other source footage to use to demonstrate Smart Trim, it might 
better represent the value this feature offers to Adobe Premiere Elements users. 
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Questions
1	 Compare the pros and cons of the Quick and Expert views.

2	 Identify the most important keyboard shortcuts for Timeline use. 

3	 What are the two modes available in Smart Trim mode, and when would you 
use each? 

Answers
1	 The Quick view timeline has the advantage during the early stages of a project, 

when you’re adding, splitting and rearranging content. Expert view is best when 
you start refining the project, especially when you start adding layers of content. 

Overall, Expert view is more capable than Quick view, and most advanced 
editors work exclusively in the Expert view. That said, the Quick view is useful 
until you become more familiar with Premiere Elements and the editing 
workflow. 

2	 Timeline keyboard shortcuts:

•	 Play/pause – space bar

•	 Arrow keys – frame-by-frame forward/back

•	 =/- keys – zoom in/out on the timeline

•	 / (backslash) fit entire video on the timeline

3	 The two Smart Trim operating modes are manual, which identifies problem 
areas and lets the editor trim them out, and automatic, which deletes all 
problem areas. Probably best if students use manual mode until they’re 
comfortable that automatic mode won’t delete some clips that might be 
technically low quality but nonetheless essential to the production. 

You know, like that moving shot where you follow your spouse in from the 
kitchen carrying the birthday cake with candles. Smart Trim might identify this 
as shaky, but you probably want to leave it in nonetheless. 
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Lesson 6: Working with Effects
In Lesson 6 students will learn the difference between curative and artistic effects, 
and when and how to apply them. In many ways, this chapter is the most important 
in the book, because brightness and color correction can make or break a project. 
It’s also the most fun, because the effects that drive these adjustments are novel 
and interesting. 

Goals for this lesson
The objectives for Lesson 6 are to enable students to apply and configure curative 
and other effects in Adobe Premiere Elements. 

•	 Your students should understand the types of effects, including curative and 
artistic. They should also understand how Smart Fix works and the benefits of 
this feature. 

•	 They should know how to adjust brightness and contrast, adjust color balance 
and fix backlighting, and adjust clip position using Motion controls. 

•	 Your students should be able to customize effects with key frames, and copy 
and paste effects between clips. 

•	 Your students should be able to animate a still image using the Pan and 
Zoom effect. 

•	 Your students should be able to change the playback speed of a clip using 
Premiere Elements Time Remapping tool. 

•	 Time permitting, students should learn how to create a picture-in-picture effect, 
and how to composite one video over another using Videomerge. 

•	 Time permitting, students should learn how to track an object and add a 
graphic with Motion Tracking. 

Getting started
This is another lengthy lesson. Many sections are conceptually difficult, yet very 
important to successful editing. It is important that you choose the most impor-
tant subjects to discuss, and make sure that you have enough time to teach 
them effectively. 

Fortunately, students can perform several exercises at home because they explore 
discrete skills in and of themselves with no broad applicability. For this reason, you 
might consider assigning the last three exercises—Picture-in-Picture, Videomerge, 
and Motion Tracking—as homework, or describe them early on as topics that you’ll 
get to only if time permits.
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Another approach might be to exclude some advanced topics, such as control-
ling effects using keyframes. This is an incredibly powerful and important feature 
of Adobe Premiere Elements, but it is also a feature that may be difficult for some 
students to grasp in 5-10 minutes. 

Finally, because the Lesson 7 is much shorter and simpler than Lesson 6, you may be 
able to extend some of the effects-related training into the following class period. 

Opening discussion 
When most beginning editors hear the word effects, they immediately think of 
Spielberg and Star Wars. But some of the most important effects are those that fix 
errors made during shooting, such as shooting with insufficient lighting, forgetting 
to white balance the camcorder, or falling victim to strong backlighting. Fortunately, 
Adobe Premiere Elements has outstanding tools to correct all of these problems. 

After applying these curative effects, students will have time to get creative. 
Adobe Premiere Elements has plenty of artistic effects, and they can really perk up 
a production. 

Using effects
Here’s where you can elaborate on the difference between curative and creative 
effects. Be sure to touch on all types of effects. Even if you lack the time to describe 
them all, the students should know that they exist. 

Premiere Elements spreads its effects and related tools over multiple panels. These 
include:

•	 Fixed effects in the Adjust panel. 

•	 Tools like Time remapping and Pan & Zoom in the tools panel that are applied 
and then configured in an effect-specific window. 

•	 Video and audio effects in the Effects panel that are customized in the Applied 
Effects panel. 

Review all three types of tools so they know where to find and customize them. 

Working with Smart Fix
Smart Fix is a mode that automatically corrects shaky and poorly exposed video, 
but relies upon Smart Tag information gathered by the Auto-Analyzer. Smart Fix is 
almost always helpful, so your students should definitely learn how to use it. 

Because the clips for the book were both shot outdoors and heavily trimmed before 
adding to a project, Smart Fix won’t seem to have much impact on the various Gator 
clips. Consider bringing in other footage to demonstrate the value of this feature. 
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Perfecting your clips
The skills discussed in the first section in this category—Applying and resetting 
fixed effects in the Adjust panel—are essential, and should be covered thoroughly.

The lessons in this section are designed to illustrate the discrete problem-solving 
effects within Premiere Elements. Since most students will encounter all of these 
over time, it’s important to work through each lesson and emphasize the problem 
being solved. Also mention that when addressing both brightness and color issues, 
it’s best to optimize brightness first, then color. 

Note that there is a Guided Edit entitled Adjusting Brightness+Contrast & Color. 
Have a look and see where it might be valuable for instruction or review. 

Applying the Auto Smart Tone effect. General cleanup. Fast and easy, but not 
a panacea. 

The Lighting Effect. Optimizing brightness and contrast, a critical skill for 
most editors. 

Adjusting Midtones with Gamma Correction. This adjustment is great for fixing 
backlighted videos (where the background is too light and the faces are very dark). 
It’s a better effect than the Shadow/Highlights effect can cause pulsing in the video 
where Gamma Correction doesn’t. 

Boosting Saturation with the Color Effect. Boosting color saturation is a fast and 
easy way to make your clips look more appealing, particularly those shot with inex-
pensive camcorders that highly compress the video during storage. 

Adjusting a Single Color with the Color (RGB) effect. Use this bring out a specific 
color, like the blue in the exercise. 

Stabilizing shaky footage
Though the depressing direction of many TV producers is shaky, hand-held foot-
age (witness Homeland), most consumer and business videos are better received 
if the shakes are stabilized. Consider including at least a mention of this section 
in your class. 

Previewing and Rendering Effects
Rendering effects is a skill that students may not need to know because the near-
real-time preview that is available without rendering provides sufficient quality for 
most projects and editors. This could be assigned as a “learn at home” section if 
you’re short on time.
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Working with Time Remapping
Time remapping is an excellent feature that allows users to apply and customize 
fast and slow motion, both forwards and backwards. Since many personal and 
professional projects include slow and fast motion effects, allocate sufficient time to 
complete this exercise. Another skill covered in this section is how to reframe a clip 
using Motion controls, which is also very valuable. 

Changing playback speed
Time remapping is overkill for many clips; sometimes a simple adjustment is better. 
Your students should at least know about the Time Stretch tool, which only takes a 
moment to demonstrate and can be essential to many projects. 

Creating a Pan and Zoom effect
Premiere Elements Pan and Zoom effect lets students produce powerful videos 
from still images. Budget ten minutes or so to cover this topic in reasonable detail 
as it is a very valuable function. 

Working with keyframes
Adobe Premiere Elements’ keyframe controls are similar to those used by Premiere 
Pro, which makes them incredibly powerful, but also somewhat hard to learn. Let 
the students know this up front, and also stress that keyframes are a critical control 
mechanism for every digital content production program. The skill may be hard to 
learn, but it has broad applicability—not only in Adobe Premiere Elements, but in 
most other content creation programs as well. 

With this buildup, working through the lessons should be anti-climactic, and 
students will grasp the concepts quickly. Don’t rush through them, though, because 
they are challenging concepts to convey and if you (or the students) miss a step, you 
won’t achieve the desired learning. 

Applying effects to multiple clips
Many projects can be completed faster if the editor can apply an effect to multiple 
clips. Adobe Premiere Elements includes multiple techniques for accomplishing 
this, including:

•	 Sharing Applied Effects by copying and pasting: In both Quick and Expert 
views you can copy and paste an Applied Effect from one clip to another in the 
Applied Effects panel.

•	 Sharing Applied Effects by creating presets: In Expert view, you can also save an 
Applied Effect to a preset that you can apply to additional clips like any other effect. 
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•	 Copying and Pasting all Effects and Adjustments: In both Quick and Expert 
views you can copy and paste all effects and adjustments applied to a clip to 
another clip in the timeline. 

•	 Sharing Adjustments via the Entire Movie button: You can’t save Adjustments 
as presets, or copy and paste them individually. However, in Quick view, you 
can apply adjustments made to any single clip to the Entire Movie via the Entire 
Movie button. 

•	 Sharing Applied Effects via the Entire Movie button: You can also use the Entire 
Movie button to apply adjustments made to any Applied Effect to all clips, so 
long as that effect has been applied to all clips. 

•	 Applying an effect to multiple clips: If you select one or more clips on the 
timeline, you can apply any effect to all selected clips by dragging the effect onto 
any of the selected clips. Once applied, however, if you need to modify or delete 
the effect, you’ll have to do it individually for each clip. 

•	 Applying an effect to multiple clips via an adjustment layer: In Expert view, 
you can create an adjustment layer over the target clips. Then you can apply 
an effect to the adjustment layer, and Premiere Elements will apply that effect 
to all clips under the layer. If you need to customize or delete the effect, you 
can customize the settings on the adjustment layer, or delete the effect on the 
adjustment layer, or the adjustment layer itself. 

While it might be too time consuming to go through each exercise, you should at 
least identify each technique to the students and discuss when they might be use-
ful. Note that adjustment layers are a very cool new feature that is definitely worth 
demonstrating (and is easy to do so). 

Other exercises
The next three exercises—Creating a Picture-in-Picture overlay, Compositing clips 
using Videomerge, and Motion Tracking—are both very simple and can be learned 
at home. As mentioned at the beginning of this section, you should consider allo-
cating these to self-study. Note that there is a Creating a Picture In Picture Guided 
edit; perhaps you can refer students to this to learn this topic. 

Time permitting
If you have time to allow the students to experiment, point them toward New Blue’s 
Old Film effect, which is a great way to completely change the look and feel of a 
video. Other very cool effects include the Lighting and Earthquake effects. 
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Questions
1	 Describe three places to find effects and tools. 

2	 What function must be run for Smart Fix to operate? 

3	 How to you enable/disable the effect preview? 

4	 What is backlighting and what’s the best effect to correct it. 

Answers
1	 You can find fixed effects in the Adjust panel, most effect-related tools in the 

Tools panel and most other effects in the Effects panel (in the Action Bar). 

2	 Smart Fix relies upon data supplied by the Auto-Analyzer, and won’t operate on 
clips that haven’t been analyzed. 

3	 In the Adjust and Applied Effects views, click the eyeball icon next to the effect. 

4	 Backlighting occurs when a bright light behind the subject causes the 
camcorder to darken the subject’s face. Adobe Premiere Elements’ Shadow 
Highlight tool is a great tool to correct this. 
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Lesson 7: Working with Transitions
Lesson 7 describes how to add nuance and dimension to movies by placing 
transitions between clips. Students will apply and preview transitions, customize 
transition settings, create fade-ins and fade-outs and to render transitions. Note 
that there is a Guided Edit entitled Adding Transitions Between Video Clips; have a 
look to gauge its utility for instruction or as a refresher. 

Goals for this lesson
The objectives for Lesson 7 are to enable students to apply and configure transi-
tions in Adobe Premiere Elements. 

•	 Your students should understand when and how to use transitions. 

•	 They should be able to open the Transitions panel and to preview transitions. 

•	 Your students should be able to customize transitions. 

•	 Your students should be able to apply the default transition to multiple clips. 

•	 They should understand how to render transitions. 

Getting started
This lesson could be short and sweet, if desired, and you should have no trou-
ble working through the individual exercises in a reasonable amount of time. 
Accordingly, you may wish to devote a portion of your Lesson 7 time to follow-up 
on any lingering issues from Lesson 6. 

Opening discussion 
Let’s face it; applying transitions is pretty routine. You drag transitions between the 
two clips and move on to the next edit. As such, the best knowledge you could pass 
on to the students is when and how to use those transitions. 

In this regard, consider starting the class with a discussion of four types of 
productions: 

•	 A variety show that employs frequent cuts between multiple cameras (such as 
The Late Show with David Letterman) 

•	 A movie (pick one that’s considered artsy). 

•	 A children’s show (such as Sesame Street for the diaper set, or Phineas and Ferb 
or Jessie for older children) 

•	 A sports show (such as ESPN’s Monday Night Football) 
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Discuss how each show uses transitions and make the following points:

•	 You don’t need to insert transitions between all clips. In The Late Show, when 
cutting from one camera to another, you don’t need a transition effect (and 
mention the obvious corollary that a transition isn’t necessary between every 
two clips on the timeline). Make the point that a cut is a transition in and of 
itself, but no effect is applied. 

•	 Transitions should be used between changes in place and time. In most movies, 
transitions are typically used between major scenes to suggest that some change 
of time or place is occurring. For example, in Slumdog Millionaire, an excellent 
example is when the two boys are pulled from a rolling train, roll into a dust 
cloud, and then reappear as young teenagers. The transition was necessary 
because moving from childhood to adolescence would otherwise have appeared 
disjointed. However, when cutting from camera angle to camera angle within 
the same scene, no transition effects are necessary. Make the point that most 
movies have only two types of transitions; dissolves between minor scene 
changes and fades to black during major scene changes. 

•	 Transitions should match the tone of the movie. In a show such as Sesame Street 
or Jessie, transitions are frequently used (usually only between scenes, and not 
within scenes), but they’re fun transitions added to match the playful tone of the 
show. Transitions should always match the tone of the event. 

•	 Transitions can also be used as branding. Monday Night Football uses branded 
transitions to jump from disparate scene to another (such as cutting from the 
scoreboard to an announcer, or jumping from instant replay to live action.) 
Make the point that all transitions should be “motivated.” The motivation is 
usually to avoid viewer confusion, but sometimes transitions are used to realize 
a high-concept visual style or to communicate branding. 

•	 Transitions are hard to compress for streaming. Also make the point that a 
transition that looks great on DVD, such as a one second fade to black, may 
look awful when compressed for streaming, simply because the compression 
ratio must be set much higher for streaming media. 

A rule of thumb is to use one-second transitions for DVD and other high data 
rate outputs, and half-second transitions in projects intended as streaming 
media. Remind students that they can change the default duration in the 
Preferences view (choose Edit > Preferences) but that the changes are applied 
prospectively, and will not be applied to transitions already located in 
the Timeline. 
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Working with transitions in the views 
Transitions are applied similarly but look differently depending upon the view. If your 
students will be working in both views, work through the exercises in both views. 

Viewing/customizing transition properties
It’s important for students to understand the three placement options for transi-
tions (left clip, between clip, and right clip) and how to access these and other 
controls in the Transitions Adjustments panel. 

Adding a single-sided transition to create a fade-in
Emphasize that this is probably the easiest way to add a fade-in to a clip, but it’s 
also the least customizable, with control over duration only. For superior control 
over all aspects of the fade-in, the student should use the Opacity controls on the 
timeline, which are fully keyframeable. You can apply these in the Effects Properties 
window (using the Fade-in/Fade out icons) or apply them manually in the Timeline. 

Applying the default transition to multiple clips
This is a killer time-saving feature that you should definitely cover. 

How transitions work—the deep dive
Transitions are easy to apply and customize, but under the hood operation can be 
confusing, particularly if you get the “Insufficient Media” error message. This sec-
tion explains when and why this message appears and how to avoid it.

Questions
1	 What’s the best transition duration to use for streaming and why? 

2	 What are the four most highly used transitions in TV and the movies? 

3	 Can you get arrested for making a movie without transitions? 

Answers
1	 Use a half-second transition duration or shorter because it typically reveals 

fewer compression artifacts than one-second durations. 

2	 Cuts (no transition effect), dissolves, and fade to and from black.

3	 No, in fact many in the style police encourage this practice. 
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Lesson 8: Titles and Credits
Lesson 8 details Adobe Premiere Elements’ title functionality. Students create origi-
nal titles and rolling credits for their productions, and use title templates they are 
installed with the program.

Note that there is a Guided Edit entitled Adding a Title to Your Movie; have a look 
to gauge its utility for instruction or as a refresher.

Also note that Lesson 12 (if you decide to teach this) will illustrate how to use 
Adobe Photoshop Elements to create graphics that can be used as titles. 

Goals for this lesson
The objectives for Lesson 8 are to teach students how to create titles in Adobe 
Premiere Elements. 

•	 Your students should understand the differences between full screen and 
overlay titles, and how to create each title type. 

•	 Students should know how to access and customize the title creation tools for 
text and design primitives. 

•	 Your students should be able to create and customize rolling titles. 

•	 Students should be able to access, apply, and customize title templates. 

Getting started
Most students already understand how to create and modify text, so this lesson is 
relatively straightforward to teach. The most complicated activity is creating rolling 
credits. Because this is something most students eventually will want to do, be sure 
you budget sufficient time to cover the subject thoroughly. 

Opening discussion 
Titles perform many functions in a video project. Most videos start with an open-
ing title, and end with credits. During the video, titles can alert viewers when the 
movie changes from one section to the next. They can also convey additional infor-
mation to the viewer, through subtitles or using thought bubbles. 

One great way to demonstrate that titles serve multiple purposes is to browse the 
title templates, and identify the purpose for each title type, whether list (to show 
agenda or contents), lower third (for overlay titles to identify the speaker), frame 
(opening title) or credits. 
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Moving on, discuss how some video producers take a perfunctory approach to 
titles, treating them as necessary evils. However, using Adobe Premiere Elements’ 
comprehensive text tools and the ability to import graphics or display a title over 
a frame or video, producers should consider titles a valuable tool for grabbing and 
maintaining audience attention. 

As a final consideration, note that your students should at least consider the 
visual uniformity between their titles and their DVD or Blu-ray menus. At the 
very least, these elements should use the same fonts. Producers can create a very 
polished, cohesive look by using the same background images, or other similar 
design elements throughout their presentation. Note that several of the Adobe 
Premiere Elements titles have accompanying DVD menus that reflect this approach 
(European Travel, Blue Notes, Birthday). 

A couple of additional points should be mentioned early in the lesson. First, pro-
ducers can insert titles over a clip (overlay titles) or can employ full screen stand-
alone titles. They can insert overlay titles over any type of content, whether still 
image or video. Though most titles produced in this lesson will include only one 
line of text, producers can insert multiple text strings into a single title. 

After you create and insert a title, Adobe Premiere Elements treats it like a still 
image, so you can drag the title to any length, apply a transition or effect, add 
motion effects as you would to a still image, or change its opacity. 

Creating a simple full screen title
This is an example of creating a full screen title. Work through the basic text 
tools slowly. 

Call attention to the title-safe and action-safe margins sidebar. Emphasize that you 
don’t need to worry about these margins if the video will be viewed only on a com-
puter (such as streaming video). Computer monitors don’t have the overscan issues 
that the action- and title-safe margins address. 

Adding an image to your title files 
Observe that you can import a full screen background image as well as a smaller 
image. Although you could accomplish a similar effect by overlaying a title over 
an image on a lower timeline track, it’s simpler to import an image because if you 
move the title at some point, the image will move with it. 

Animate a still title
When teaching the material in this sidebar, make the point that these effects are sepa-
rate from the motion effects that you can apply to any still image on the timeline.
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Superimposing a title over video clips
Whenever you superimpose a title over a video clip, the most important consider-
ation is legible text, especially when the background video is moving and chang-
ing in color and brightness. To maintain design consistency, you should identify a 
single visual design that works irrespective of the background video. 

Design strategies include adding a border or background shadow to the title text, 
or, as in the exercise, adding a translucent box or other design primitive. Note that 
these design primitives allow producers to get very creative with titles. 

Using graphics
Premiere Elements includes multiple graphics that you can add to your projects, 
including speech bubbles, which can be tons of fun. This lesson details where to 
find these effects and how to apply and use them. Note that there is a Guided Edit 
entitled Animate Graphics Easily. Work through the Guided Edit gauge its utility 
for instruction or as a refresher. 

Creating a rolling credit
As mentioned earlier, rolling credits can be complicated to produce. Consider 
using the rolling credit from the supplied project, and allowing students to experi-
ment with options such as Start off Screen, and Pre-roll, Ease-in and Postroll to 
produce different results. 

Emphasize that you control the speed of the rolling credits by setting title duration. 
Stretch the duration to make the title move slower, reduce duration to make the 
credits roll faster. 

Questions
1	 Where are the title templates found?

2	 What’s the primary consideration when creating an overlay title?

Answers
1	 In the Titles & Text panel in the Action Bar. 

2	 The primary consideration is ensuring text legibility. You can do this by applying 
an outline or shadows to the text itself, or adding a translucent design primitive 
beneath the text. 
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Lesson 9: Working with Sound
Lesson 9 examines multiple audio-related features, including a real time narration 
tool; the ability to create, add, and modify soundtracks; and a mixer that controls 
the volume levels within clips. To become familiar with these features, students 
create a background music track, adjust the volume of an audio clip, add sound 
effects, add a narration clip, and mix a final audio track. 

There are two Guided Edits for this chapter, Adding Scores to Your Movie and 
Adding Narration to Your Movie. Consider working through these to determine 
where they might fit into the class learning experience. 

Goals for this lesson
The objectives for Lesson 9 are to enable students to create, mix, and apply effects 
to audio tracks. 

•	 Your students should understand how to use Scores to create custom length, 
theme-specific background music for their productions. If they’re upgrading 
from previous versions of Adobe Premiere Elements, make the point that Scores 
have replaced SmartSound for the background music function.

•	 Your students should understand how to use Smart Mix to automatically mix 
the audio tracks in the project. 

•	 They should be able to adjust volume with the audio mixer, using rubber band 
controls on the timeline, and using Adobe Premiere Elements’ gain controls, 
which now can be applied to multiple clips simultaneously. 

•	 Your students should understand how to create narration tracks. 

•	 They should be capable of applying and customizing effects to audio files. 

Getting started
This lesson has two logistical issues to consider in advance. First, the students will 
need to hear audio tracks much more clearly for sounds mixing than for video 
editing. Whereas speakers may have worked well during video editing, headphones 
might be preferable to use for this lesson. If you don’t already have headphones 
available, you should encourage students to bring their own, even if they’re only 
iPod ear-buds. 

The second issue relates to narration. If each computer in the class doesn’t have a 
microphone, you should consider asking each student to buy an inexpensive micro-
phone for her own use, which can cost under $20. Note, however, that configuring 
individual computers to recognize and use a microphone can be time consuming. 
As an alternative, consider demonstrating how to create a narration track, and 
using the same narration track for all editing activities. 
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Opening discussion 
Begin the class with a discussion of the importance and impact of audio. 

In all productions, audio must be noise free and properly mixed. As when applying 
curative effects in Lesson 6, the audio techniques taught in this lesson will improve 
the quality of audio tracks and the final audio mix. 

•	 In business productions, background music provides a general polish. 

•	 In movies, background music can help set the tone, and reinforce the emotions 
in scenes. 

•	 In home movies, background music or narration can provide the continuity that 
the typically disparate scenes lack. Play the completed movie that comes with 
this chapter without sound to make this point. Note that TV shows and movies 
have storylines and dialog that carry the viewer from start to finish, but most 
home movies don’t. A strong audio track can smooth over the lack of continuity 
in home movies. 

Background music, in particular, is a home producer’s best friend. An 
acceptable home movie without background music is just OK. An acceptable 
home movie with great background music can be a great movie. 

Adding background music with scores
Scores are ideal for business presentations that need thematic background music 
(OK, elevator music) that most people don’t have in their personal music collec-
tions. In addition, it’s also lots of fun for movies in which thematically appropriate 
music adds a nice atmosphere. 

Work the students through adding a Score to their projects. 

Adding narration
This exercise covers the mechanical aspect of creating a narration track, but not the 
artistic aspect. In most instances, for best results, students should prepare a script, 
read it several times, and print it in short sections in large fonts. Scripts should be 
written to suggest the way people talk, rather than the way they write. 

Also discuss the environmental aspects of recording a high-quality narration, mean-
ing access to a quiet room with no air conditioning/heating noise. Also identify what 
a pop filter is and why students should consider getting one for recording narration.

About waveforms
This lesson describes what waveforms are and how to diagnose audio problems 
using a waveform. It’s a great theoretical section that really sets up some of the 
volume adjustments described later in the lesson. 
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Adjusting audio volume
Be sure that students grasp the difference between adjusting volume in the volume 
graph and adjusting the volume using the gain controls (see section Volume, Gain 
or Normalize?). To make the distinction, you can detail the difference between 
normalization and manual volume controls. Consider covering these fundamentals 
before actually describing how the controls work. 

One of the key differences between the volume graph and the gain controls is 
that you can adjust the gain of multiple clips simultaneously, which is a very 
convenient feature. 

Adjusting project volume with Smart Mix
A totally cool feature and fun exercise. The exercise makes the point that you might 
have to perform some adjustments manually after applying SmartMix, and you 
should make that point as well. 

Raising and lowering volume with keyframes
Inserting keyframes is much more intuitive and contextual in the timeline than in 
the Properties pane. Consider teaching this skill entirely in the Timeline view. 

Working with the audio mixer
Emphasize that the audio mixer is a useful tool, but it usually only creates a “first 
draft” of the final audio levels. In most instances, students will need to fine-tune the 
settings produced by the audio mixer using rubber band controls and keyframes. 

Edit to the beat of your favorite song
A very fun and useful feature for those creating slide shows from digital pictures. 
Worth demonstrating if your class includes a lot of wannabe Ken Burns (who pro-
duces movies with extensive use of still pictures with pan and zoom effects). 

Working with sound effects
This lesson is ancillary to the other content in the lesson. Consider describing the 
difference between normalization and compression and then assigning this for 
additional home study. 
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Questions
1	 What are the pros and cons of adjusting volume via gain controls and the 

volume graph? 

2	 In what situations is audio normalization hard to apply? 

3	 What’s the difference between normalization and manual volume adjustment 
and when should you use each. 

Answers
1	 When working with the gain control, you can adjust multiple clips 

simultaneously, and all adjustments reflect in the waveform, so you can see 
the affect of your adjustments. However, you can’t apply key frames to your 
adjustments, so they’re applied universally to the clip. When working with 
the volume graph, you can only edit a single clip at a time, and adjustments 
don’t reflect in the waveform. However, you can apply key frames to your 
adjustments, so you can control volume adjustments within a clip. 

2	 Normalization works poorly in clips that have loud and soft regions, when 
the obvious objective is to raise the volume in the quieter sections. Because 
normalization is limited by the loudest sounds, normalization often does 
little to boost the volume of the quieter sounds. One alternative is to split 
the clip into high and low volume levels, and normalize the lower regions 
independently. Or, use rubber band controls to select specific areas of the audio 
track and adjust their volume manually, at the risk of introducing distortion. 

3	 Normalization boosts volume of the entire audio track to the maximum decibel 
level that doesn’t distort the loudest regions. It’s best used when the audio levels 
in the track are relatively consistent (as narrationtracks). You can adjust volume 
manually using rubber band controls or keyframes, which is a preferable option 
when an audio track includes widely varying volume levels. Manual adjustments 
can introduce distortion , however, so you should be careful when performing 
manual volume adjustments. 
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Lesson 10: Creating Menus
Lesson 10 is aimed at students creating a Blu-ray or other optical disc from their 
projects. Students will add menu markers to videos; and learn how to create, cus-
tomize and preview menus. Then, they’ll create a Web DVD, and burn the project 
to a DVD or Blu-ray disc. Because Adobe Premiere Elements can record a disc 
image to a hard drive (in addition to writing the content directly to a disc), your 
students need not have a DVD or Blu-ray recorder to perform these exercises. 

Goals for this lesson
The objectives for Lesson 10 are to enable students to burn DVD and Blu-ray discs 
from an Adobe Premiere Elements project. 

•	 Your students should understand the system requirements for creating and 
playing DVD and Blu-ray discs. 

•	 Your students should understand how an AVCHD disc differs from a Blu-ray 
disc and why and when it’s useful. 

•	 They should understand and be able to add menu markers to their movies. 

•	 Your student should know what an auto-play disc is, and how to create one. 

•	 Student should learn the techniques of creating a menu template, including 
inserting background video or images, adding background audio, and animating 
menu buttons. 

•	 Your student be able to preview their discs, and record the project to Web DVD 
or traditional DVD or Blu-ray disc. 

Getting started
This is a long lesson, but critical for students who want to burn optical discs 
containing their content, or upload a DVD-like experience to the web. Depending 
upon the technical level of the students, some may be totally unfamiliar with the 
technical requirements of producing optical discs, so you should introduce these 
issues first. You may also have to spend significant time explaining menu markers 
and other disc-development similar concepts. 

Fortunately, some of the later sections are comparatively simple and can be worked 
through with little additional explanation. Finally, if the students have DVD or Blu-
ray burners and the necessary media, you’re good to go at the disc-making stage. 
Otherwise, fall back to plan B, which is to save a disc image on the student hard 
drives. This process is very similar to burning a DVD, the primary difference being 
that the hard drive is chosen as the destination medium in the last dialog. 
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Opening discussion 
If your students are not familiar with optical disc production, start out with a brief 
DVD primer. At a highest level, DVDs have two components, menus and content. 
The two processes of creating a DVD are adding menu markers to the content so 
viewers have input points, and building a menu. Adobe Premiere Elements does all 
the linking and encoding. 

Blu-ray production is identical to DVD production, except that you output to a Blu-
ray recorder rather than a DVD recorder. Introduce the concept of a Web DVD, 
where students can create and upload a project that will work like a DVD on the 
web, including clickable menus for navigation and video playback. Then discuss 
AVCHD discs, which allow you to burn HD content onto a standard DVD recorder 
and DVD media. 

Then, list the technical requirements for producing a DVD/Blu-ray disc. 

To create and play a DVD, the student will need:

•	 A DVD (or Blu-ray) recorder (most Blu-ray drives are backwards compatible 
with DVD) 

•	 A blank recordable (DVD+R/DVD-R) or rewriteable (DVD+RW/DVD-RW) disc

•	 A DVD player or Blu-ray disc player. You may wish to note that commercially 
manufactured DVDs will play on virtually all DVD players, but recordable 
DVDs will fail on between 5-10 percent of DVD players. 

Observe that a single-layer DVD can store about 4. 7 GB of data, and a dual-layer 
disc can store about 8.4 GB, sufficient for 90 minutes or 180 minutes of high-
quality video. To include more content on the disc, you’ll have to increase the video 
compression which may reduce audiovisual quality. 

To create and play Blu-ray disc, the student will need: 

•	 A Blu-ray recorder

•	 Blank Blu-ray media - either BD-R, which is write-once media, or BD-RE, which 
is rewriteable. 

•	 A Blu-ray player. Note that compatibility problems exist Blu-ray players and 
Blu-ray recordable discs, but they’re not as well documented as the DVD 
incompatibilities. 

A single-layer Blu-ray disc can store about 25 GB of data, enough for at least two 
hours of HD video at very high quality. While dual-layer, 50 GB Blu-ray discs exist, 
Adobe Premiere Elements records single-layer Blu-ray discs only. 
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To create and play an AVCHD disc, the student will need:

•	 A DVD (or Blu-ray) recorder (most Blu-ray drives are backwards compatible 
with DVD) 

•	 A blank recordable (DVD+R/DVD-R) or rewriteable (DVD+RW/DVD-RW) disc

•	 A Blu-ray player.

When discussing compatibility issues, emphasize these have nothing to do with 
Adobe Premiere Elements. Rather, incompatibilities are often media related, or 
caused because many DVD/Blu-ray players were released before recordable tech-
nology existed and pre-dated compatibility testing. 

One tip is to use recordable discs, which are usually more compatible than rewrite-
able or erasable media. Another strategy is to avoid dual-layer media, which can be 
less compatible than single-layer discs. 

Also you’ll want to manage expectations on the disc features that Adobe Premiere 
Elements can generate. Specifically, while discs created with the application share 
many features with commercially-developed discs--such as chapter points, and 
audio and video menus--the navigational features available in Premiere Elements 
are very structured, and the program lacks the support for subtitles or multiple 
languages, as do virtually all other consumer-oriented DVD authoring programs.

Make the point that you can make Blu-ray, DVDs and AVCHD discs from the 
same project; it just depends upon the disc output that you select and the type of 
recorder and recordable disc. Whichever you choose, Adobe Premiere Elements 
will format the video and record the disc appropriately. 

Understanding DVDs, Blu-ray and AVCHD discs
This is a good opportunity to make sure that students know the difference between 
DVD and Blu-ray discs and understand the myriad of variants (+R/-R/+RW/-RW/
BD-R/BD-RE). 

Manually adding scene markers
Scene Markers are critical to controlling the viewer’s access to content. Students 
may be familiar with the term “chapter points” which are used elsewhere. Note that 
Scene Markers allow Adobe Premiere Elements to generate Scene Selection menus 
just like commercial DVDs. 

Few students will want to create an auto-play disc or automatically generate Scene 
Markers, which are discussed in next two sections. Consider touching on these 
topics but, in general, working through these exercises probably wouldn’t be a good 
use of classroom time. 
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Creating a disc with menus
This section reviews the types of menus available and how Adobe Premiere 
Elements always displays the relevant commands for each. This section could be 
skipped if time is short. 

Modifying scene marker buttons
This is an important and straightforward exercise. Observe that button labels 
should only be one or two words in length; otherwise they typically won’t fit within 
the button shape (and remain legible on a standard TV screen.) 

Working with submenus
Consider covering the “Three types of menu markers” sidebar before diving into 
these materials. That way, the students will learn what the links do before they 
learn how to apply them. 

Customizing menus with video, still images, and audio
This and the related exercises in this lesson are critical territory because most 
students will want to customize their menu templates. Make the point that if the 
student wants full screen video in the menu background, they need to choose a 
menu template without a drop zone. 

Also note that while a producer can perform DVD menu customization, doesn’t 
mean that she should. In particular, moving thumbnails take a long time to render 
and look pretty funky, and since video and audio menus have a maximum duration 
of 30 seconds, after which they repeat, looping thumbnails can be irritating in use. 

Creating Web DVDs
Discuss that you must host a Web DVD on your own website or a website you 
have FTP access to. Then walk through the straightforward process of creating a 
Web DVD. 

Burning DVDs, Blu-ray Discs, and AVCHD Discs
Choose a teaching strategy that suits whether recorders will or will not be available 
in your classroom. 
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Questions
1	 How should students address incompatibilities between writable and rewritable 

discs and some DVD and Blu-ray players? 

2	 How much video content can a DVD contain while retaining very good 
audiovisual quality? 

3	 What’s the maximum duration of video menus and what happens after then? 

4	 What’s a webDVD?

5	 What is an AVCHD disc?

Answers
1	 They should inform their viewers that incompatibilities are an unfortunate fact 

of life. Since some of these problems are media related, once they find a media 
brand that works for them, they should also stick with it. Students should avoid 
rewriteable and dual-layer media. 

2	 Placing more than 90 minutes of content on a single-layer disc can require data 
compression levels that will degrade video quality. 

3	 The maximum duration is 30 seconds. After that, the video starts over and 
replays endlessly, sometimes to irritating effect.

4	 A webDVD creates a set of files that a user can upload to a web site for playback 
via Flash-enabled computers using the same menu controls available on a DVD 
or Blu-ray disc. 

5	 An AVCHD disc is a standard DVD recordable disc containing HD content that 
can be played on Blu-ray players. AVCHD presentations can also be recorded 
onto Flash drives and other media for playback on a range of devices. 
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Lesson 11: Sharing Movies
Lesson 11 explores how students can share videos with friends, family and associ-
ates, including uploading videos to YouTube, exporting a video file for viewing 
from a hard disk-based or mobile device, and how to export a still frame from a 
video project. 

Note that the book doesn’t cover how to upload content to Adobe Revel because 
this feature wasn’t available in the software until just before it shipped. For the most 
part, operation is very similar to YouTube, so you should be able to walk through it 
very easily. 

Goals for this lesson
The objectives for this Lesson 11 are to familiarize students with their options for 
sharing movies produced in Adobe Premiere Elements, aside from the optical disk 
platforms discussed in Lesson 10.

•	 Your students should be able to upload a video file to YouTube. 

•	 They should be capable of exporting a file for viewing on a hard drive-based device. 

•	 Your student should learn how to create a file for uploading to an iPad or other 
mobile device. 

Getting started
Adobe Premiere Elements supports multiple ways to share videos, and the most 
desirable method will differ from student to student (and project to project.) Some 
students prefer using YouTube, some want to email to friends or post to a web site, 
others want to upload videos to their iPods or iPads. None of these are conceptu-
ally difficult, but you’ll have to budget your time carefully to make sure that you 
explain them all. 

The common concern in all these methods is encoding time, which can be lengthy 
on older computers. You may get the best results (and save a lot of classroom time) 
if you take the students to the brink of each sharing method, but never click the 
Save button (or cancel the encoding process after you do). 

Opening discussion 
Ask the students to open their Publish+Share panels and then identify and briefly 
discuss the output options one by one. Then, to get the students involved, ask them 
which option is most important to them, and perhaps ask students interested in a 
particular technique to lead a discussion on that output option.. 
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Uploading to YouTube
Premiere Elements makes it extremely simple to upload files to YouTube, with 
multiple presets for different resolutions and aspect ratios. There are also presets 
for Facebook and Vimeo for students using those services. 

Sharing on your personal computer
First, review the Choosing output formats sidebar to familiarize students with 
the available formats. Discuss the strengths and weaknesses of each format as 
described in the sidebar, and ask the students which formats they plan to use. If 
QuickTime doesn’t predominate, consider changing the exercise to the most popu-
lar format. 

Be sure to explain that FLV is the most popular format on the web (for Flash 
players), but it requires a special desktop player for playback outside of a browser 
environment. Most users still don’t have such a player, which is why it makes little 
sense to email files in this format to friends. 

Ask if any students will be publishing their files to a web site other than YouTube 
or Facebook. Dig into details like which site, and research that site’s encoding and 
uploading requirements, so all class members can learn which formats and encod-
ing strategies should be used. 

Explain that when students create files for other video distribution websites such 
as MetaCafe or blip.tv, they should check the site for file uploading requirements. 
If the upload rules aren’t followed, the videos may look suboptimal or may not 
be accepted. 

Exporting to mobile phones and players
Ask which devices students will be using. If Apple devices don’t dominate 
(unlikely), work through the exercise using the most popular device. 

Exporting a frame of video as a still image
This is an important exercise because still frames are useful in both titles and 
DVDmenus. Suggest that exported frames are often the best starting point 
for a DVD menu. 
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Questions
1	 When are FLV-format video files appropriate, and when should you avoid them? 

2	 How do you know what format to encode to when creating a file for a user-
generated content website? 

Answers
1	 FLV files are appropriate when creating a file to upload to a website for playback 

on a Flash-compatible browser. However, you should avoid using FLV file for 
desktop playback unless you know that the person you’re sending the file to has 
an FLV player. 

2	 Most sites list their specifications and requirements in a FAQ or similar 
document. 
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Lesson 12: Working with  
Adobe Photoshop Elements
Lesson 12 details how to use Adobe Photoshop Elements and Adobe Premiere 
Elements in concert to seamlessly combine digital photography and video edit-
ing. To complete these exercises, students must have Adobe Photoshop Elements 
installed on their computers. 

Goals for this lesson
The objectives for Lesson 12 are to familiarize students with methods for combin-
ing the use of Adobe Premiere Elements and Photoshop Elements. 

•	 Your students should know how to use the Edit Videos command in Elements 
Organizer to create a slide show in Adobe Premiere Elements, and how to paste 
images into Adobe Premiere Elements. 

•	 Your students should be able to create a Photoshop file optimized for video, use 
the file in Adobe Premiere Elements and then return to Adobe Photoshop for 
subsequent editing or touch up. 

Getting started
Intuitively, we know that most videographers also shoot still images, even if the 
reverse isn’t true. These facts suggest that most Adobe Premiere Elements users 
will be interested in learning how to improve their productions with Photoshop 
Elements. Of course, this doesn’t mean that teaching these techniques fits your 
class curriculum. This is especially true if your class computers don’t have 
Photoshop Elements installed, a necessity for completing these exercises. 

However, the concepts in this lesson are relatively simple to grasp, and could be 
covered in a ten minute fly-by, if necessary. On the other hand, the exercises in this 
chapter could fruitfully consume a full 45-60 minute class period. You decide. 

The one scary prospect to consider is that a basic familiarity with Photoshop 
Elements is assumed. If you’re starting from ground zero with novice users, you 
could lose them very quickly. Keep this thought in mind when deciding how to 
approach this subject in your class. 
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Opening discussion 
Consider opening the discussion with a show of hands of those students who have 
Photoshop Elements installed on their home or office computers. Then ask how 
many students also shoot still images for standalone use or for integration to their 
video productions. 

Then discuss the high level benefits of using the two programs together. Most sig-
nificant is the ability to edit still images in Photoshop Elements for use in Premiere 
Elements projects. 

Getting started
This is an efficient way to gather images that you’ve previously catalogued for use in 
an Adobe Premiere Elements project. 

Creating a new Adobe Photoshop file optimized for video
Introduce this discussion by identifying a number of purposes that optimized 
still images can serve in a video project, such as titles, menu backgrounds, and 
text overlays. Note that Adobe Premiere Elements’ title tool is very capable, but 
Photoshop Elements adds an additional level of feature sophistication. In essence, 
this lesson teaches students how to use Photoshop Elements as a high-powered 
titling utility for Adobe Premiere Elements. 

The lessons also detail “round-trip editing,” which lets the student create and edit 
an image in Photoshop Elements, include it in a Premiere Elements project, and go 
back and forth between the programs to customize the title. 

These exercises are conceptually simple but detailed, so go through them slowly 
and make sure that your students keep up. 

Question
•	 What is the key benefit of using Adobe Photoshop Elements along with Adobe 

Premiere Elements? 

Answer
•	 Adobe Photoshop Elements includes many additional still image editing functions 

and effects. Using the two programs together allows Adobe Premiere Elements 
video producers to efficiently access these functions in their productions. 




